0 Luminar 4 Luminar

4 — IR EFT A Sep 19, 2020



HR

LI T 1 T R s st O PO PR RPTRPRN 4
2. LUMINAE A A . ieeeeiiieeeeeeeetieceeeeeeeeeeeeeeeeereennneeeesssssnssssesssssnsssesesssssssssssssssnnsneessssssnnnssssssnnnnnnesssnnn 5
2.1, LUMINGAE A T A & B R R oottt 7

< KT BV IO O S S (a7 /b A | SRR 17
3.1. WindowsIZH1FBLuminarD AV AR =)L ET VT ANRTURY (i 18
3.2. macOSICHIFBLUMINArD AV AR =V ET DT ANRTURY (i 20
3.2.1. Mac App StoreDSLUuminarZz A > ZR—Jb ..ccccoiiiioiiee e 22

3.3. LUmMINar 3MB DT YT T LR oo e 23

A BIVEBRIE oottt ettt ettt sttt e e st e s e s e at e et e e s e na et e s e e e e snnnaae s 24
D LUMINAI D T T3 eeeeeieieieeeeeeeeeeceeeeeeeeeeeeeeeeesssnseesessssssssseseesssssssessssssssssnsssssssssnnesessssnsnnsesesssnnnnnns 27
5.7 TR T T AIVDIITN oottt 28
5.2. Luminar@ B —BR T T A9 —E L TDERTTIE (oo 30
5.3, Luminar&E it DY TR T T T7 7 —HE T oo 33
5.30. TTTAUDAY ZRTID ittt 34
5.3.2. Adobe Photoshop TLUMINAIZ ET D ..oooviiiiiiiec e 35

5.3.3. Lightroom ClassicTLUMINArEEE D ..o 38

5.3.4. Adobe Photoshop Elements TLUMINArZ I D ...c.ooviiiiiiiiicice e 41

5.3.5. MacD B E | DILFRIEBEE L TOLUMINarDERTTIE oo 43

5.3.6. Apple Aperture TLUMINArZ EI D ..o 46

5.4 AT T 49 —ELTOLUMINATDME AT oo 47
5.4.1. Skylum Luminar 4 TDCapture ONeDfEFTIIE ..o oo 48

6. L — AT T RADMEE ...eeeeeeeeeeeteee ettt e e e e e e e ss e s s e s s s sssssnnnnnnnaseaaesataaeaaaessassassas 56
0. . A T T i e 57
0.1 1. TA T T U Il /N ettt 58

0.1, 2. T T T A R e, 61

. 2. B R L e 63

0. 2.1 R Y Il N e 64

0.2, 2. R R T A R e 70
0.2.2. 1. B RN TUn oo 71

0.2.2. 2. B E D B B R oo 73

0.2, 2. 3. B o s 74

6.2.3. BN Y = JUEIVE .o 75

B. 3. B R L ettt 76
6.4, T AL =DV T — Il AN D B T oo 77

7. R R ITIER A BIC ceeeeeeeeeieeiieticeeeeeeettteeeeeteeeeeeeeeeeesnsesseeeessnnssssseesssssssssessssssssnsesessssnnnsssesssnnnnnnasans 79

T B B R T R R oo e s 80



72 R A G T A I U T BT oo 84

7.3 AE) == RDBDAUTRTD oo 90

: Jn Tk AR 3 A R V115 - Sy < RPN 94
BT A N Il oo 95
8.2 AU /N AN Il oo e 98
B3  AIRRT I T AU Il oo 100
B4, FIT U Il oo, 102
8.5 FAERZEMEY Il oot 104
B.6. T AT I I /NU Tl oo 105
B.7. JAZBRZEY Il oo e e e e, 108
B.8. TURRT =T I /NI T Il oo 109
8.0, TR Il oo, 111

720 I ot R A By V2701 1 L Ay < 113
T  AIRTIA )T LR R Il oot 114
Q1T AIRAA )T LU=RAR Y R ARTAY oo, 116

9.2, AIZEDHEBRE Y =L oo e e e, 122
0.3, ARBBTEY Il oo, 124
0.4, RTRT YT Y Il oo e e e e, 126
0.5, RNl e, 127
0.6, BT Y L oo, 128
0.7. AT —RFAIU(LUT) Y Il oottt 130
0.8, TURTFHT 7N LA Il oo e 132
0.0, T I Il oo, 133
0.10. TAIVIT LA Il oo 134

0. T FB Y Il e, 135

0 [ et N e Ny 175 Y L Sy - U SPRRSRRN 136
10T ALRF D s INTH Il e 138
10.2. IR DU /N T )l e e 140
10,3, /AT Il e, 144
104, N R R e, 145
i B m bk A2 o | A Rl | 7 Ly RS 146
111 BRI R T AR Il e 147
11,2, BT BETR T DT T Il oo e 148
113, BUMEEZE JFEZIATIY =l oo e e e 150
T4, I T TN Il e 151
TT 5. BB TAIUA Y Il oo, 153
11,6, AT YRR I T )l oot 154

R S AW & Rl 170 - Sy R 155

120 AT R TIER Y = I oo, 156



13.

14.

15.

16.

17.

18.

12,2 BU TN Il 158

12.3. DO &RAB U T Il oo e 159
124, L ZETD T RN Il oo et 160
LUMINAE LOOKS ..cneniiiiiiiiiiiieiittiteteeeeeetecetereeencecececesesessscscessssssnsssscsssssssnsssncsssssssnsssscnsnsssanansnsns 162
13,7, LUMINAr LOOKS DI T ..o e 163
13.2. BANDLUMINGr LOOKS LU Y MEFRHEIA ..o, 165
13.3. Luminar LOOKS(Z VY R)DIIR G T AR oot 168
13.4. AR LsLuminar Looks(Z Y R) /ST DB c.oovveeeeeeeeeeeeeeeee e 171
A A7 DD LN J5 eeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeeesesesssnssssssssssssssssssssssessssssssessessssssssansnnssssssssssnnnnnnnns 172
T . AN DR e, 173
LR g D /a1 L Ay < OO TOTTRR 174
T4, 3. R LA A D U JT et 176
V4.4, R U T UATTDVEBR .o e e e e 183
TA. S, AN DZEHR oot 184
14.6. LAY —TD T LY REZRDBEUNT oo e, 187
LUMINAIrD T R U T DT T T eeteieeeeeeeeeeeetteetaeetaesesessssessssessssesssssssssssssssssssssssssssssssssssssnnns 202
150, LA R AT DUEY TT oo ettt 203
15.2. IR DY) T oo e e 204
15.3. TS R AT DIEUN T oo et 205
154, FBTIR T R DN JT oo e 207
15.5. TSTATUR R AT DIEUNTT oo 209
15,6, BEEE T A DB UN T oo e 211
15, 7. D D R R D R B E R T .o e e 213
B R DEEME «.vveeeeeeeeeereeeeeeeeeeeeeeeeeeeeeeeesessssssssssssssssssssssssssseseseeseessssessessssssssssssssssssssssssssssssessseseenes 216
16. 1. B DD B ER IS D UN T ettt ettt 217
16.2. ZAT S )E 2—CDEHRDFEM . ... 219
16.3. VT IELI—TDEIRDEIMM ....ooovoeeeee oot 221
16.4. B EFM T BRRICER DT —TR—RIUI—=RIYD e, 223
FERDEETE ......oeeeeeeeeereeeeeeeeeeeeeeeteeeeeeeeesssssssssssssssssssssssssssssseseesssssssssssssssssssssssssssssssssssssssssssssesesens 224
171, 3= M AV R B U CEEE R DIT D oo, 225
17.2. 7AW =R UTEIREEIR oo 227
17.3. A —RIDEIRDFEED ..o 229
17.4. R D T2 I — E R D BE I oot 231
17.5. THILT =BT FZAIVEHUBR oo 232
17.6. TIL/N BB LB R EE IR e 236
17.7. B—EREEIL V23V DOTILINLAANDBEHIRDFIEED ..o 241
2 WAL Bl <ty e D = 242

T8 B R DD IR IR A T A I ) T e 243



19.

20.

21.

22.

18.2. RAW + JPEG/RT DMLIE .. oottt ettt ettt ettt et ene e 245

18.3 BRI IT AREE X .o e e, 247
184, BB D B .o 249
18.5. TED R A ..o, 250
18.6. TS FETA I — D EUNTT oo e, 252
18.7. R R E D R EE P R AN D I T oot 255
y 2 DA B 0L (= SRR 258
LT B o B = < 1 G B A OO U RSO URRROOPRRROPPRI 259
19.2. BBEUD I T DIEUNTT oo 260
19,3, FIF AT DI INT T T I T e e e et 263
19.4. BEIRED /N DT U T oo e e, 266
TTAIDIRIFE T ZATRD e eeeeeeceeeeeeeeteeeeeeeestnnneeeeesssnsseseessssssssesssssssssssesesssssnsnssssssssnnnnesnes 267
20. 1. I O R T oo 268
20.2. TRD I ZTR oo e et 269

20. 2.7 R T T A IV DARTT oo 270

20.2.2. HR—=RINTWBTFZAILDTER oo e e 272
20, 3. BRI B A oo, 273

20.3.7. Sharing an IMage t0 SO0PX ....uuuuiiiiiiiiiiieiee e 274
20.4. BED/NYT IR e, 277
S N M= B S B N PRSP 281
27,1, MACOS D I TR — R I T N I N e e e 282
271.2. WINAOWS D A — TR — R T N A0 D e e e, 286

LUMINAE B T D R B LI e eeeeeiiieieieeetee it iaeteetatesrassansassassassassassssssssssssssssssssssssssssnsensensansans 290



Skylum Luminar - 4

1. Luminar 45 Z#F

Luminar 4

Your
photograp
Elevated.

BEORE, Ffl. /I — T A% ERLDHENBRYECIA...

Luminar 4 C. HR7-DEEIIFEHON FAEIEICEEDY I —FIEAEETITRA BRELBEKRIKRET—BEN
LWEEFWDOTEHLRIDFTTIT,

Luminar 4i3. B DEBEERICHELRIRTOEBEEREY IV E—DICLIzA—IL- A4V DVDEBEET7 ST, IFA
DM T, HOWIEEEZBVDEFIC IMOER ETHERREEZTWV. ZTOITXRTORABEEIVI) I TH>EW
SBEICABTCEEXT . F. HOWRBEERDT—I7O0—DTSTAVELIUONBIT(H9ELTEREBELE T,

s BEYODEBPARKREBEERIIE. 79y TEZDLuminar Looks*., tIUIRE, /4 XfRE. BIEBIERE
DORNAY—IVERW Y FINRTTO—F A KERETT,

« HiRELELC<Luminar Looks, €L CLuminar® & FRY — L ZE> TRDEFEN. HoEWIEICERIBES L LY
BEENHELENVET,

o EREBEP IOV aF NI TSI LAV—TLYRE—R TIRFv—A—N—L A REBEA=21—
REDZHRBFEY I’ FLLOBELREEREDARELELITET,

©2020 Skylum R—2 41290



Skylum Luminar - 4

2. Luminar 4D %5

.

¥

A
o
o
5
|

Luminar 4ixH5PBLRIVDBERD=HDYIRNITT DV IM—D TR TOBERERESLMEENTA. BN
AR REM B ZHLE T,

Luminarix. 29> R7Ay -7 r—2ay TS5 40  FHIEABIT149ELTERTEEX T, COEHBRY—IL
DETDA—H—IL YV TN RBEEEELEEEFEA. HOWIGECERELET,

o RAVRTOAY-TTNG—=23v FlE—BRUBRKRAN- 7TV 5—2a3vADTS 71V ELTOFERTE. H5
WBRYMIICELET7—70—3%1R,

« Al Accent— tHR CREBFREEIVN\VY—,

« B60LLEDEFZLuminar Looks, H7R/=DFHICEHOETIVI)Y I TEREZRETEET,

s AYOTANDEIMERTFHREEEIEEHL2100%IEMIEHNTEL VRS,

o Luminar® A7 ZY/RRIVIE BIRERIEE P RICEE, DV TN RAVI—T7z—RLY . EEA B EICEH
BELELOIENTEET,

s SATSYNRRIIEFRAL. GEICEEOEE FE, . /-T2 TEET,

s LAY — TSV RRFVTIERIBOEIRIIREE IR M,

o W ITYTT—=TIV(LUT) 774N EBRTEIET IV IATATRAZT—ITL—T AV T ETIVLRARYY -

2al—vavEIFVEY,

©2020 Skylum R—T5/290



Skylum Luminar - 4

o NRIRAXARERTSVEBIRMBRIRAF VT VAT ALY, EEAHEIEATREICAYET,

s BRICEDLDILFARENMTON A ZRERL. ERO"NUEL ZTIERETTIZEE R,
« RAW.JPEG.TIFF. 8&UZDM— D77 I ALY R—MLET,

« NyFABTEHOEREZTIEFPIBETEET,

Luminar 4% 21X, HRT-ODBEIF-BEEFIBEDFEI VYT DELWAVY—TT— I, TRTDEGRE

RLARETIODRBEINAFr N RERELET . FEHITEICBEEDT IIL—TILA B TITRA BER
EERBT—BRLWEEL WD TEHRTDFITIC

©2020 Skylum ~R—26/290



Skylum Luminar - 4

2.1. Luminar 40O BEL MR &=

Luminar 4

Your
photograph
Elevated.

BEREICISLSHELLE

Luminar 4D EFHIRY—IILEAITZ /O —E. BEREICH AT EEEEE5LET,

©2020 Skylum R—T 71290



AIANZ I Fv—

WRDBRYBL VAN I Fv—Y— )L EALTHlEZRATLEE. FEDRALBNSVEDR>TLEIZENE
<BHYFEY ., Luminar 413 WEAK(AREL . E. K BEYRE)ZBHNICH L. Thboes BN KRYBHEZAL
TEELEIAIRNSIFvy—Y—LIZ. BEERDOAYZBERICRAMUBRIQNEEE T HENIBARBEIT
BEFDOREBEZEFALIT.



Portrait

Al Skin Enhancer

AIRAF> -T2\ —

AIZFY - ITUNVH—RBEDAREH T/ OV =& (BRI TRO)BEDHICHEZITRTDIALI ERERAL, BRPE
REZDEDREBZREDD, LAREELRYKRE N ZEBOMNMILET  BREOBEIELT Iy THRETE, FiHP
DY ATICERAA<HEERELET,



Skylum Luminar - 4

Portrait

Al Skin Enhancer

Portrait Enhancer

AR—M—b-ToN\VHY—
R—RML—b TNV H—DEFHAILFTEMICEY, 15~60 TRERR—M — N ElBE. B. OZKDELDICEL

I2BEOY—IVICEY, 2 TOLRIVODBERNREAFERIEAVMI—IILESONET. T Y MIFLWEE
CEICBEMICGAEINZE TN\ FREN BRI AEEILLYHERMIZ]

©2020 Skylum ~R—210/290



Skylum Luminar - 4

Creative

Al Sky Replacemant

AIZRDA-YTL—ZAAV K
AIZBA )T L—ZAAV MY —IVIEZE T TR B A ETOERDOAZIEBAN—HTELIICBEELK

ZRHELIT . ERERTVILIVILR NG E B BOELEDOMEBEITRHL. NOERT—T 17770
N—RIZvIEHIBRL. SOICRTROBAZIEAV IS AN HEREATRETT

©2020 Skylum R—T11/290



Skylum Luminar - 4

Essentials

AY—h-aAVFS AN
FLOWRAY—KMOVRSAMNY—LIE REEDAVRNSAMNY—IILEYEEBR O DN, AEKDBET(T—ILER DS

T EYNTAREGREERLET, G BEAELUE ETBE0IC BT TS RABBET(F RARERHLTH T
I,

©2020 Skylum R—T12 /290



Skylum Luminar - 4

R

e

2ENLRI—H—THIZARYIT VR (UX) DKIEAHE

Luminarsf EHRDOHREIEIN/=Luminar 4, Luminar 3O F5E% ., 1—H—H Al ZLTTEA LR
IZILuminarz2 DN EWVWHIIRTREER, CHICEDWTHAEFXI - —D=Z—X %G /=9 7=HICLuminarz KIigil
WERLEL,

s REDHDIAVINETAPTIOME L

o AVH—TJI—ABEDOEBEDILR

s V= ADIYEERTIER

« RERRSAY—

« AVH—TI—ZADIAVISAMDREIL

©2020 Skylum R—T13/290



BEREIhRETE 21—

Luminar 4Tt WV—ILIZBMRICEED LN, TRTOY—IL DALY FEWNPTLARYF L. &Y —ILIiE. BIBEDER.
FEP)TATAT R BREBERABFEVLET . Z<DTAIIDHRNSTINIIEBHIMARFERE AT TEIRET %
B URILVERBCBREBILLEEYEZZET,

TRTOY—ILIEEDDY THICEE,

s FYUNR - BEANOEAWREERY IV VRS B EERE,

s TvtyIvIL - BEANREREBE. b—VFERY— I REEBROEANRINITICHERIRTDY—I,
s INIAT4T - ) ITAT47RBEBNEY—)L,

o R—IML—hk —R—KL—FD7HDY—IL,

o TO7zvoatl - SURBINSERBEENEA1TILOHDY—I,



Essentials

Denoise

HRINL/AXBREY—IV

HOWBIATDEENST VI /A X ETEICRE AAZPHREFMGICEAFRLAELVERZH I,



Creative

Color Styles (LUT)

ZLDFLW RIS BEBMINIT TV NAT—RIMIV(LUT)ZA TS

BEBIYEV T L ) IAT14TTHLWERZ LUTIZ. A5 L—FT4V 7 BEZTHR. FIETIYILTAILAR
My OICERTEEY,



Skylum Luminar - 4

3. LuminarQA > AN—ILET U747k

Luminarid, 7 7)o —2av 7S04V OmAELTAVEL—SITAV AN—IVBE LV T IV TAR— TEEXT,VIH
VITEAVAN—IVTBHENC AT ZTITEaHEDLET,

JVE1—9DOSERTAN—DNHRH THEHIEEHR LTI,
FHTEAREMEDDHEI7AT IA—ILFE IV ARV IR IT T HENICLTLE I,
VINIZT BTV TAR—RTBEDITAVI—RyMIERLTWSIEZMEE L TKEIW,
Luminare 7S AV ELTAV A= T BRMDEANT TV r—2ar g RTIRT LTLEIL,

o nh =

AV ZAN—=ILDFMMICTDWTIE, macOS F/=ik. Windows TS EBLEIL,

©2020 Skylum R—I17 /290



3.1. WindowsIicHBlFBLuminarOA > AM—=IL.ET
DTAR—3Y

DITHANDOYINIITEEATZHEIE.VINIZTEYIVO—RLTAV A= T 2RENHYETRDF
B%RT LTI,

1. POTAR=23VA=)LbDFIvO—R)VIBEARICTRLRAIGEEINE &Yy ILET . VIho 74
VAN=FZIF. IES MBI O—RTBIEEHETEET ,

2. 9vO0—RI74 NI —RHDOAYZAN—S%IFT,
Luminar4Setup.exe #85 7IVLVUvILTAVAN—=ZT T r—av &L AV A M= T O X %A
LEd,

4. SAEVRBHERBLERLELZL. AET2 RV %EI)yILTRITLET,

Installation: Luminar 4

Licensing Agreement

END-USER LICENSE AGREEMENT
'LEASE READ CAREFULLY BEFORE DOWNLOADING ANY SOFTWARE FROM

REE TO BE
STITUTES YOUR

Accept

5. 7TV —2avDAVAM=IVEEBRBL AVAN—IVEFTETESSTAVERIRLET,

Installation: Luminar 4

Destination:
C\Program Files\SkylumiLuminar 4
y ;| Adobe Photashop

¥ 5 Photoshop Elements

v Adobe Lightroom

Install

6. 1VARN=IHRTLES A=ILT7RLRAEAAL, Luminar 4%i&&) #7)vILET,


https://downloads.skylum.com/luminar4/installer/win/Luminar4Setup.exe

Skylum Luminar - 4

Installation: Luminar 4

Luminar 4

Organize. Edit. Express. Enjoy.

Launch Luminar 4

& Optin to receive photography editing tips, insights, inspiration stories,
product updates, discounts and more via email from Skylum team.

7. Luminarzif# L. EERAHEEZHE LHLEIN,

8. 2EIHDEHT.VINIZTETITAR—INTEET N TNR—=RAZa—T PIOF4R—k Vv oL A=
TRULRET VT AR=230F—(TOTAR—=2aV A= VIS AF)VEANLIZBR AVAMN—ILEEFETTL
9,

Vb
9 lELuminar® h A7 LD SE L TH =W EWD AL, Skylum.comiZF7 2t XL TLuminarX
%9V BENTATIVIRES D O—R$B) IO HYETS,

©2020 Skylum R—219/290



3.2. macOSIcHBITBLuminarOA AN —=ILET D
TAN—3Y

DITHANDOYINIITEEATZHEIE.VINIZTEYIVO—RLTAV A= T 2RENHYETRDF
B%RT LTI,

1. POTAR=23VA=)LbDFIvO—R)VIBEARICTRLRAIGEEINE &Yy ILET . VIho 74
VAMN=ZE. IBE5 LYFHO—RFTBIEETEET,
2. 9vO0—RI74 NI —RHDOAYZAN—S%IFT,

3. Luminar4_Installer.zip 29 77 )y I LTAVAN=5F7 ) r—2av w28 L. AV A=) 7O X %5
BLET,
4. SAEVARWEHRBLARLELE BETS R0y L TRITLET,

Installation: Luminar 4

Licensing Agreement

END-USER LICENSE AGREEMENT

PLEASE READ CAREFULLY BEFORE DOWNLOADING ANY SOFTWARE
FROM THIS INSTALLER:

This End-User License Agreement (this “Agreement”) is a legal
contract between you and us.

ABOUT US: Shinyfields Limited, a company registered in Cyprus
(company number HE 256351) with a registered address at Avlonos 1,
Maria House, 1075 Lefkosia, Cyprus trading as Skylum Software (“us”
or “Skylum").

BY INSTALLING OR USING THE SOFTWARE IDENTIFIED IN THIS
AGREEMENT, YOU ACKNOWLEDGE THAT YOU HAVE READ THIS
AGREEMENT , THAT YOU UNDERSTAND IT, AND THAT YOU AGREE TO
BE BOUND BY ITS TERMS. YOUR USE OF THIS SOFTWARE
CONSTITUTES YOUR ACCEPTANCE AND AGREEMENT TO BE BOUND
BY THESE TERMS AND CONDITIONS

Decline Accept

5. 7TV —2avDAVAM=IVEEERB L. AVAN—IVEZFESTETST1VERIRLET,


https://downloads.skylum.com/luminar4/installer/mac/Luminar4Installer.zip

Installation: Luminar 4

Destination:

Applications/

Adobe Photoshop

v Adobe Photoshop Lightroom

/ (&) Adobe Photoshop Elements

Install

AV ZAN=ILDFTET LI A=V 7 RLR%ZA B L, Luminar 4%28) %#0)yoLEY,

. Luminarzi2giL. EEAMEEE B R LALIEIN,

. 2EBDEET.VINIZTETITAR—NTCEE T M TN—AXZa—T 7IF4R—M %D )v oL A=)
TRUVRETITAR=23VF—(TITAR=3 VA=) AF)VEANLIER AVAN—ILEEFFETTL
x99,



Skylum Luminar - 4

3.2.1. Mac App StoreH*SLuminarz{ > AM—JL

Mac App StorehSLuminarzfE AT 2555 I ROFIEICHE > TIEIL,

Mac App Store %=i#2EILET,

MZFZET1—ILRICLuminarc ABILET,

Luminarz:&RL. BBARYVEIYvILET,

Mac App Storeh*SApple IDE/XRT—RDEREERINDIGELHY

7,

Luminarld7 7V — 3> 7245 =¥ ovO—RIhEd,

6. FinderT #& > 77V /r—>ay #&IRL, I Tluminar? ) r—<a
VERLET,

7. Luminar? ) &S TNy oL T TV r—avwRELET,

oD~

o

Luminar? 7)o —>av&BIBRLTLE 27235 & & Mac App StoreSBY UV O—RFTBIEHNTEET,

o=

Luminar®Mac App Store/XA—Tavid, TS5 74V ELTER T EEEIRELTVWEREA. TSY
AVELTERTER/N—Y3val ABDH & Idsupport @ skylum.comiZZERLSLZIWV BA
SERRAECIRIRLTCW R ZET TS TMVELTHERATERN—VavaTRBEWALE T,

©2020 Skylum R—222/290



Skylum

3.3. Luminar 30607y 7L —NK

Luminarai WA= 3y S8 ICT7y S L—R,

Luminar - 4

s FRA—HY—-ELTAVZAb—IL EALCFIBICHEVET,

« Luminar 4i3EHWAN—230 2 BEBICHRE L. 22— —DLooks&E MV AM—)LENFzLooks/Sy o &2 IE—L
x9,

o Fl BHWNA=UavAERELANS, IBIEOLuminari¥0s ##H LW \Luminar 4407 ICE#LE T,

ot Luminar 3HYO7EFHTCIERA EVDIIS—HRRILBEIE TFHLWASOT EER ] 58
RLTLEEIW, T EEAL! Luminar 4% EIT T & D SLuminar 30 A9 O 5 ZE# 52 &
TZXY,

©2020 Skylum ~R— 231290



Skylum Luminar - 4

4. ENEIRIE

Microsoft ® Windows ®0)*‘/17_-A£{4::

HWEEIRYY:

Intel®Core™ {75 714X LU,
AMD Ryzen™7 g2t L&

T34 4GBLLEDRAMAB A T=T 1A 2')—MGPU
AEY— 16GBLLEMDRAM

Windows7®(64E"y hOSMD &), Windows8.1®(64E™ k
OS?D &), Windows10®(64E Y NOSD )

FARIVBRE  T5147)—KR547&LT.SSDIC10GBDZEEEXR &=

RIETEH1920x1200DFRIRE = FOF+v) TL—av X
nrEE=4—

7otyy—

AT A

T=4—

RIERARYY :
JOtyty— 237 DIntel®F 2 IZAMD® CPU
T>57499 Open GL 3.3 &M E #eit
XE— 8GBLLEMDRAM
AT Windows 7LABE(x64E Y NOSD #)
TFAAVBE  10GBOLEXRE

E-y— 1280x768LL L DR IRE

BREZRVWTIEREIVVITDE VAT LADEKREZHETEEY,

©2020 Skylum R— 241290



Skylum

& Home About

| Find a setting L I -- W. d 10
. HE] INAOWS

3 Display PC name

Rename this PC
[ Notifications & actions

izati 'WORKGROUP
@ Power &sleep Organization 'ORKGROU

Connect to work or school

= ey Edition Windows 10 Pro
= Storage Version 1703
0OS Build 15063.674
8 “abletiriode Product ID 00342-50681-97978-AAOEM
O Multitasking Processor Intel(R) Xeon(R) CPU E3-1505M v5 @ 2.80GHzZ
2.80 GHz
&1 Projecting to this PC Installed RAM 32.0 GB (31.8 GB usable)
System type 64-bit operating system, x64-based processor

Shared experiences
x B Pen and touch  Touch support with 10 touch points
I ® About Change product key or upgrade your edition of Windows
Read the Privacy Statement for Windows and Microsoft services

Read the Microsoft Services Agreement that applies to our services

Read the Microsoft Software License Terms

Apple® macOS®m> 27 L EH:

WREIARYY:
7oteyHy—
T27499
XE—
AT
TARVRE

E=4—

BIERARY S

Joteyy—
T271499
XE)—
AT I
TARIRE

T=4—

Intel®Core™ i7 7t LLRE

4GBLL EDRAMAE A 7=T 1A 0"')—MGPU
16GBLL_EMDRAM

macOS 10.12L4B&

7347 —RS547TELT. SSDIC10GBDEERE

RIETH1920x1200DRIREEFOF v T L—a v
nE=4—

237 DIntel®
MEBTZT71499H—K
8GBLL_EDRAM
macOS 10.12LAF&
10GBOLE XA E

1280x768 LA E DR IGE

[CDOMacllDWTEEIRT 28 VAT LDERREN—RIT TR TEET,

©2020 Skylum

Luminar - 4

R—225/290



Skylum Luminar - 4

CITATCETN Displays | Storage | Support | Service |

macOS Catalina

Version 10.15.1

MacBook Pro (15-inch, 2019)
Processor 2.4 GHz 8-Core Intel Core i9
Memory 32 GB 2400 MHz DDR4
Startup Disk Macintosh HD

Graphics Radeon Pro Vega 20 4 GB
Intel UHD Graphics 630 1536 MB

©2020 Skylum R—26/290
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Luminar - 4

Luminarid $ R TOEERDEHIC, BHOBGHERBLEBOEAICH LITEAIC. HLPZHETI—F—%

HR—MLET,

« Luminark 29V R7OVIT T 49— ELTDFEWNA
« Luminarz AEIT T 15— ELTOFEWEA

s Luminarz 75742 ELTOFEWEA

s 475 TDLuminar@fEWH

©2020 Skylum
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https://www.youtube.com/embed/Xcybk4YiXy0?rel=0
https://www.youtube.com/embed/Xcybk4YiXy0?rel=0

5.1. Wi 771 IL DR

Portrait

Al Skin Enhancer

Luminarid, SEIFRT7MINFERICH G LU IFEAEDHASH L OC—BH LTS 749y RITEELET, N7
714I)b:

XN 2714973

 PNG

+ JPEG

« TIFF (8-bit, 16w )

* Apple HEIC files (Mac® #)
« PSD

I INRAWTS I

+ .CR2
+ .CR3
 NEF
+ .ORF

.RAF



Skylum Luminar - 4

 .ERF
« .ARW
« .RW2
+ .DNG
+ .PEF
+ .PPM
o Ip&

HIBAAZ D) AMIZEE%E 2)vD

WIinINTOWEVLWRAWER TOEE

LuminarCR B INTOWRWAXASHSEGR AR GEE L. BIREDNG 771 IIVICERTZHELHY F T, DNGIRS
IEAASHTHRETEET, /2L, Adober S ER D DNG Converter AV AM—=ILTEET,

LuminarlZ . DNGZ77M LI IS LTH Y AASTOIREEFICERIN/DNG T 71 )L, £/ IZFRAWFE XN SDNG
ConverterCER SN =771 L2 FRHTEET,

ot LUk
Adobe DNG Converters 4V AR—JLFDE, FAMNY—IILDFEMBRE LI aV CERTESEF
BDNGHAZTO77/)bEA—RINZET,
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http://l.skylum.com/luminar-4-supported-camera
https://helpx.adobe.com/photoshop/digital-negative.html
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5.2. LuminarQBE— BRI T149—&LTDEHA
&

LuminarC. 1 DFIFEHDEGR Ay avELTHE. ZTNODOEIRICERMN, ZL TV IA T4 T RREETT
STENTEFT A TavELT.INSDT7MILDIRERBE A Luminarh Y QT IR ETEET,

1. FILWASOT ZEN. X BFOHIOT %2 FEAFLWASIOT 2N T HICIE. 7700 > A%90O7 > 5
.. EEIRLET,

2. 771 > B—EHRZRE 20y L. BEE%ERT D, Cmd+O(macOS) 7l Ctrl+O(Windows) %3
LEFTHLWII17OT Ry AN BEET,

File Edit Library Image View win

Ctrl+Shift+N

3. WEYIEBZEEER.
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4. BEICDBEABLY -V EEA, RERBRIAIATI771VICEBNICREINET.
5. 774 > THRR—b... FLlE 770 > HE 2ZRL \WEINLHFLVEKREZS 27 LELLD,

6. WELALVROEGRZRCKIE, LEDFIRZEYRLET,
7. FATSVICHYEZZE E—DEKERDIFBIENTEIT  BE—EHEREE Ya—bMivhes)vILKE
I,
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ot Lk
BEOBEGRET TV r—avTAAVIINDSY I 5L, —EICAKIENTEET, —EICHVWEE
HOBEREBEICHPYB ZZITIE, TIIVLRARN) Y T(IREE 21— > T4ILLRRN) Y T HRR)DEF]
Ta_o

o =

R

RELLBEZRIZEBEFHNICHYOVICREINT T AREELLACARVGEIE. B—BG®REEIL I3
VTERZZEIRL, DeleteF—&#L T IV, 77 )LIELuminard SEIBRINE T A, /N—KKS
A7IIEERYVET,
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https://www.youtube.com/embed/jYgiwPS-OtA?rel=0
https://www.youtube.com/embed/jYgiwPS-OtA?rel=0
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5.3. Luminar& ittt DV IO 7 % —HEIC

Luminari& ZILEED RSV R7OY -7 )5 —2aVy IR MO —REEREV 7NV T DTS4 ELTHER
TEHIEHTEFT HHDIITHAIDSI I O—RULAVAN—=IL LB MDAV AN—ILBFEHFDYINIZT DTS
SUAVEAV AN —ILLET,

Luminarix. SNSDT7 )5 —2av DTS4V FIEABIT49—E L THERTEET,

Mac & Windows

 Photoshop7 571~

+ Lightroom Classic 71>~

+ Photoshop Elements 7551~
+ Capture OneAEIT 45—

Mac® &

* macOSOEETSY
* Apple Aperture
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5.31. 754> DAVAN—=IU

Luminar 457504V ELTAVAMN=ILTBFTaVIiE AV ARN—S%5RTTEHEIIICRRIINET, Tk #EH
S5TSTAVELTAVAMN=ILTBIEETRETT,

1. AVAMN—IVHRDRANT TV r—2av g RTRTLET,

2. Luminar 40'ADMNTWBIE R LET,

3. Luminar4 > 73574 %AV AM—)b... (macOSDIFE)E/lE 774 > TS 71V AV AN—)L
(Windows D37 &) & EIRLE T,

Uningal

iral idcka Chotmensg Bermars

4., RRINFA7O7 - Ry ZARDEMDRANT ) r—oav58IRL, AVE1—YRICHZB P R—IIh
TWBERANZ ) r—2avaERRLET,
5. LuminarCERALIEWRIET FVD[A Y AN—=IVIT7 VAV AN=V]RE V&I )y I LET,

! 3=

*  AL—RIFIBEEDBEDOIC. TSTAVEA Y AN—=ILTBENRANT T r—ay
(Photoshop/2 & )& T L TKIEIVW AV AN =LA T I57/HDIC. BEE/NRT—RD A %K
HONBEENHYET,
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5.3.2. Adobe Photoshop CLuminarz{g&s >

Luminar?®, Adobe Photoshop®ig& 3727 ANV —JLICLuminar 4% 749 L THERTBIIEIUTOFIEESE
TLTLEIL,

1. Adobe Photoshop%i2&8ILE T,
2. WELEZVWEBRERTEY,

3. 74JL% > Skylum Software > Luminar 4... ZZ#iRF 5 &, Luminard AZ LW 1707 D KRT.
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Ps| File Edit Image Layer Type Select Filter 3D View Window Help
Luminar 4 Alt+Ctrl+F

Convert for Smart Filters

®N + - Auto-Select:  Layer

(c) Javier Pardina)_F21A9985.CR2 @ .
Filter Gallery...

Adaptive Wide Angle... Alt+Shift+Ctrl+A
Camera Raw Filter... Shift+Ctrl+A
Lens Correction... Shift+Ctrl+R
Liguify... Shift+Ctri+X
Vanishing Point... Alt+Ctri+V

D

Blur
Blur Gallery
Distort
Noise
Pixelate
Render
Sharpen
Stylize
Video
Other

Skylum Software »[ Luminar4 J

vyvVveVvVveVvVvTVv VYYyYVYO®w”

4. REDPOEBGEI Luminarc BEIMICRAKD T MBICIHEUTRY I EIEI RV /NN—ICHBLuminar7 AV 5D
Yy LIV EZET,
5. LuminarCiEAITWE T, /21X Luminar LooksA W7 —/ 70— AE—RK7v /]

6. TET LA EARYVEY) v L, GRELE&%ZPhotoshoplliXEYIRLE T,

oo EUh
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Luminari&PhotoshopD AY—k 74 )L —&LTDERHIEFI | Photoshopl 1 ¥ —42 AT —K~F T
VIJRELTEEL. BEESYLuminar’S 71 % EE L TIRE L9, PhotoshopliC R2THS
LAY —%0)v 95T WOTELUMINArciI s LiREEL VA THEET,
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5.3.3. Lightroom Classic CLuminar& f#&

Adobe Lightroom Classic (£ 7z(ZLightroom 6) D E/{&% . 2R {LuminarCim& L &> ILightroom Classic CCH5
LuminariC 77L& ZEBIITL T OFIEZETLTREIL,

1. Adobe Photoshop Lightroom ClassicZ&E&L %7,
2. Lightroom ClassicDZ4 7Y F/IFBRIRES 21— LT RETIEHRZZRLE T,
3. ROWTNADAHZEEZERL. Luminar 4TIRELE T,

BEEAZa1—

1. BE > #R%E > Luminar 4 %:®#3R$5E T, LightroomM SLuminarilBEAES N FTLWI A 7O HEE
ED

2. ROATavoWTnmhaBIRLET,
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Skylum Luminar - 4

+ LightroomifETOE—%#R&E — Lightroom TiTo7cim&EE 77 IVISEIGE ., AIE—IhE& %
LuminarCiRELE T . Y170V Ry I RARADA T arCaE—T771 IV DEEMBIRTEET,
- AE—%{RE - LightroomTHIET 2FIDTTDER 77/ A IE—LLuminarCiR&ELE T . DA T
avIE. RAWZ71 L TIIERELEE A
s TEEEREE - \—RKRRS147 LDOLightroomTHIET2HIDOTD 77V ERELET . DA T3y
IE.RAWZ 7ML CIXHERELEH A,
3. AE—T7AINA T avEBIRL IRBERYIVEV)vILET,

! FE: BE > REAZ1—ICLuminarh’ R W B & &, LightroomDIRER €% BE Y, Sy s
THBEIRL. VYNl DAYOTE—EIREA TV avaFovIBRLET,

774 X=a—
INLOWTNHERBIRTZIEETEET,

« 774JL > Export with Preset > Luminar 4 Edit a Copy with Lightroom Adjustments] — Lightroom
TII2mEZ 771 )VISEIG LLuminarllEFLET,

« 774JL > Export with Preset > Luminar 4 Open Source Files —5tD 771 JL (Lightroomig&E#4L) %
Luminar 4I332ELE Y,

« 774J)L > Plug-in Extras > Transfer to Luminar 4 — 5t 774 L %ZLuminarllEELE T, 2OAFoay
[FRAWZ 74 JL%&Luminar 413259 57, 771V DT —I9DREZRYMBIEWVREICRETT,
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Luminar7 >4 TOiwEE
T7AIDEEINDE REDEBIITTTY,

1. RwPFEIFYRIN—|ZHBLuminar7A4aA>%2")y- L, LuminarlictIVE 2 F 9,
2. LuminarCRAZEAITWET, Luminar Looks&Z{#W, 7—270—%2AE—RK7v 7|
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5.3.4. Adobe Photoshop Elements CLuminarz
HHD

Luminar%Adobe Photoshop Elements& &S5, Luminar 2749 —ELTHERATBIEUTOFEIEEERITLTL
2N,

1. Adobe Photoshop Elements%#2&ILZ 9,
2. Photo EditorE¥2— LT mELEZWVWEREREET,

spunt e o Be

3. 74JL%— > Skylum Software > Luminar 4... Z:®IRLZET,
LuminarlC BN ES N LW A 7O D REET,
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Create Share -
Adpril ety -
q
s
=
. :A Esposu
w
v da
Ut
Ii' -— ok
d ]
- 8 o Balance.
+
B s
- = SN ol 3 = i~ @ O
Pt Towl Oypies el Lot Moy Oegang Howes 3iws [t 1550

4. REFOEGEHN» LuminarCEEIMICEKD T, Ry FIZF9 RO /N\N—IZHDLuminar7A V&) v LYY E
ZFEY,

5. LuminarCiRAZEAITWET,Luminar Looks 7 —JAR—R&FHL, 7—/70—%2AE—RK7v /]

Aprly
»

6. BT LELGERRYVEI)vI L, A LB & %Photoshop ElementsiTiEYRLET,
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5.3.5. MacD [ BEE | DHihREEsEE L TDLuminar
DIERAAE

BFEVWDMacDOSY AT LD/IN—3V 1011 ETH BB E. LuminaraMacD TBEE | 77 O 3RIERE L TE
Be2ZENTEET  MBEEILREZZBIRT D AEIIRDESYTY,

1. YRATLRIEREZER,
2. %ﬁ%%ﬁ%ﬁ%%ﬁo
3. BEZER,
Extensions
Use Apple and third-party extensions to customize your Mac.
All . =
AV HhircBarv axtensions Select extensions for editing photos:
ol Markup
Finder Extensions v/ Aurora HDR 2019
iCloud Drive, C and 2
Photos Editing
Markup and 3 more... M * Luminar4
Photos Projects
JJIFILM Prints & Gifts and 2 mor...
Quick Look
Share Menu
4. [FRTBILREEEAZIRLE S Luminar 42— L TLEIL
5. 77V —>3y 7405 —H6macOSDIBEE | #REILET,
6. [EEIDSATSTHRETIEGEERLIT,
7. MERYVEI)YILET,
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Edit Photo

8. ILBRMEERY V&) wo L, Luminar 4%:8IRLET,

Aurora HDR 2019

® External Editors
> Luminar 4

A App Store...
) Manage...

9. LuminarCHEA1TWE T, Luminar Looks Y7 —J7AR—RA&FRHL. 7—770—%AE—RK7v 7|
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—_ )

M.J

Creative

10. ETLAL. EEERFRSVZV )y LA LELEBREMacD [BEE | 7T )IEYIRLET,
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5.3.6. Apple Aperture CLuminar&{E& >

Apertureh 5D Luminar®E{E (L. LightroomTD HEE LTV E T, Aperture N SLuminarlil 771V %2 179 %
ICIFL T DO FIEEETL TSI,

1. Apple Aperture%&EELZE T,

ApertureD 5475 HSLuminarCEELAVERERIRLET,

3. BE > {RE > Luminar 4 2 BIR$2H BEiR%E=4GH7") Y2 LT Edit In > Luminar 4 Z:&RLEJ,

Filo  Edit | Photos

=allse Q
L] i Vasar
ey [ <

§

Saite use RAW Driginaty Sharpener Pro 3 (2): Output Sharpener.
P Pagged Switch Al to use JPEG Originaly Sharperser Pro 3.0 (1): RAW Presharpener.. |
Siver Efex Pro 2.

Topaz Fusion Express 2..
SMAREC “ Vivezs 2.

Detete Previews fof Library

IR T I s

4. FLLWEBEIPERIN, LuminartlEEINE T,

LuminarCiAE AT\ E 9, Luminar Looks Y7 —Y AR—R&FHAL. 7—270—%AE—RK7v /]
6. BT LELGERRYVEIY v LB LB, ZAperturelTEYIRLET,

! a8
Apple ApertureldBElE S /=728, macOS 10.15LABETIXFEILE H A,
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54. A TT149—ELTDOLuminar®{ERA A%

FOMDERITAI— BT IINT YN R—Sv—5ERHTEE. 7ML EBDOT T)r—oavitEELT
MIBHEFY, COFKICLUMInar A TEIRWIBNRA TS SA VA E—TB2EDHFEFT,

» Capture One7—270—

©2020 Skylum R—I 47 1290
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5.4.1. Skylum Luminar 4 CMDCapture OneD{&E
AA*E

Luminar 4i$Capture OneMo&FBICF VA TE ERLET /70— D—HELTH/WWLITET. TTO
A—H—ISERVAEEFET A EYDFRAWEKRNDT—I 7O—ICA ZAATY,

[Edit With...]a~x > R&@FEA L. Eif§%Capture OnemSLuminarilBEILE T EEARER. TD 771 L DREICE
FRAHNTEET, ZLTFHLWAY TR I71)LELTCapture OnellFiFAHINET, ZDIYI1TDT7—270
—E TSV RNy T iRE I &ML, Capture One A" HEELTWET,

« ERIZHEAICCapture Onell > TUEBINZET,

s T7ANIE. BEEEFRDEHEEYNEIF16EYMNDPSDEAIFITIFF 774 L E L TRBEINE T (ZDRHRIC
ETIFFRERXA&ETY),

o TTOBIFAZERDIDH. ProPhotoRGBEZEEDFERAZHEIH L X T (Adobe RGBEEATIBETT ),

ZDT7—070—FUTOFIEZEEITLTILEIW,

LuminarzBWic9 5

Capture Oneh*SLuminar~D7 7t A A%,

1. Luminar 424V A=)V . T ITAR—RINTVWBIEERER LTI,
2. Capture One% &)L, Cmd+ (Mac) £7<Il& Ctrl+ (Windows) 1 L CERE/ ARV ERAZET,
3. Plugins¥#7 %27y L%E9,

o Plugins

O ® T ad o hE A DR

General Appearance Image Capture Color Exposure Crop Focus Warnings Update |Plugins

Open With Menu

Open With Open With Menu 1.0.0 by
Allows to select and use applications installed on the computer in order to open

files from Capture One
Disable | This plugin cannot be disabled
Allowed applications | Q. luminar 41

¥ * Luminar 4

4. Allowed applicationsDRFENR Y ZICLuminar 4& AN L. BRIDHEICH D F TV IRy I RICF v % TF
ER
5 BREVAVRIERALET,
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RAW 774 L% LuminarlliE(g
RAWZ 71 )L %Capture OneHhSLuminariCiEICEN. RAWIZ 7ML AFER LS EE TOREEITIDITERN T,

1. 729 TIRET 2EGRERIRLET,
2. RAWI77M I ERETEIBAIF(FLIFERINTWAWVEEREZ EELuminar 4103%/53 %384). Image >
Open with Luminar 4 #2RLET,

Edit With !
Open With ») Adobe Photoshop 2020
Publish »s| Adobe Photoshop CC 2019

Adobe Photoshop Elements Editor
Set as Compare

) . _ > Luminar 4
— ; Other... [%

Essentials

4. 7714 > TV RAR—MaER L, LuminarQREY A 7O #HEE9,

5. FILWI7AINZEERLTEML, 771V EDEEZEIRLET,

6. Capture Onety>avFF 47 IVICBRBLE T (CDHBAIRDIIRAR—NDIHICEEINET).
DFARIN L SRWIEEIE, Capture One TEI%Z:EIR L. Image > Show in Finder (Mac) F7z(& Show in
Explorer (Windows)%®RLE T,
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|_7CL Search

Date Modified

g
b

= % =/ > B Trash

=) B Capture

B8 Output

Bl Selects

» [ CaptureOne

Sharpen: [
| Original

X

ProPhoto RGB B
_TIFF E

Compressi |
Depth: [16 bits

Resolution: [ 240 | [ pixelsfinch

(owrader ) (cance

T '\.._‘\ T'.'.;s’

ignett

7. [774)%&  Luminarl %, &RIZ0 DN ZWERICEE L BY A 77V R EBERZERLET, LEIE—
RREICHEREINTWSERETT,

8. ®RE V)Y ILEY,

9. Luminar 4%2E L7-IKEET. Capture OnellR2ZENTEZET,

10. Ef&lZCapture Onety > avFdH4O7ICEBMICEMINET,
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E21A8857 1_Luminar.tiff

wE Lz E{RALuminarllE (S
Capture Oneh 5, Luminarld7=27171v 7 5%(,

1. 720 TIRETHEIREERLET,
2. Capture One CiEZIT o>/ &. ZDRBEFDI7M )L ZLuminarllEETEET,



3. FAEFEDIT7MILELuminar 4ICEET BB EIE. A X—Y > BT Luminar 4 Z:&8RLFT UTOA T3>
%%TR’C“%?TO

Edit With | = Adobe Photoshop 2020
Open With »| Adobe Photoshop CC 2019
Publish Adobe Photoshop Elements Editor

.~ " Luminar 4
Set as Compare o | &= Preview l%

Clear Cor

Other...

4. LYEERE 14707 DEKRITHSEER A ZEIRLET,
5. Depthx=a—T#EAEYNREZRELET(16E Y MiERE),



r Capture One Session.cosessiondb

% O A B O N O £ 2 #2-

2 Luminar 4
Basic Adjustments Metadata

Format TIFF = 6 bt

<>

Options Uncompressed

ICC Profile Adobe RGB (1998)

G K K>

Resolution 300 px/in

Scale Fixed

<>

100 %

Cancel Edit Variants

6. REIIHLT. ERCEEEEEZERLES, [Adobe RGB] E7-I&ProPhotoRGB | A #E LT . fRIKE S
SUORT—= AT aVvEERBLRVWTLKEIWEL. BEOY A X EE BT 255 I1EMR),
7. Adjustments¥#7%7%!)v4 L. Disable Sharpening4 7> 3> &lgnore CropA 7o av AR LET,
r Capture One Session.cosessiondb

R @ A B O . O £ 2 2-

2 Luminar 4
Basic Adjustments Metadata

Crop Respect crop

Sharpening No Output Sharpening

Cancel Edit Variants

8. MEMRT LES. ATV NRERSVES Yy sLET, LuminarB BB, 77 LEERI AR Tt
Exnzxd,
9. Luminar4V—I%=FRALTEGREZRELZT,



10.
11.
12.

13.

Essentials

Al Enhance

T74I > THRR—K %ER L. LuminarORESY (7O 5FEEET,

HLWI7AILZER L TEINL, 771V EDEEZEIRLET,

Capture OnetyavFiE 1473 ) DBMICBEILE T (CDIFFTIRDITIRAR—MDIHICEEINE
T)o CDBATD OO LR WHFE I, Capture One TEfR%:#IR L. Image > Show in Finder (Mac)& 7z (&
Capture One (Windows)%®iRLZE T,

‘'ssentials

|Q search
Nam Date Modified
2 ! | Enhance

» i CaptureOne

» [ Capture

th: (16 Bits B
Resolution: ( 300 ] | pixelsfinch B
= - ignette

| New Folder | | Cancel |

P

FZ7AINCODYRTWERTZ M T B R 77V R EBEBZRIRLI T EFBIC LEEDREIHRES
hi—d_o

14. RE=IVYILES,



15. Luminar 4%/Xv 2575 RTERITL/-FZE T, Capture OnellRBIENTEET,
16. E{RlECapture OnetzyarvFiidh4O/ICEHENICEBMINET,

LE R J x b

17. Capture One CERDREFELZRITI BN ROBEEICEAZET,

EFE:

LD AEHI Capture Onetzyar TOEETIIHRBETY . CNICKY ., FRPDEREBEEICHEERL. Finder/
ExplorerC74)\ 4 — &%= R A CEET WOV 7 O0—F %= FEHAT 2568, B EETIEITA. ThoDEA
VIR RBICRDIZGEDHVET,



6. 1—H—AH4—TJ1x—ADE

Essentials

Al Structure

Luminari&. 22D ERMEEASIAVMA—IILTEET,

s SA475) Ea—hmo. BEABESLVNFTES —NTEFET,
« BE 1T EGEAETIENTEZET,
A== IV TIVTRELPTVWIIICT A INTVWET,
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ol Fa

'_i_____;“‘ |

_
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6.1.1. 4T3 -Y—)L/\—

ERDFEICEL My Y= ILNN—IIFEAEEOEVWELDIATYRIEEN. FUOPTUVERICHEERICTIIL—F
EINTWET,

N

Fle Edit Lbrary Image View Window Help
f
Add Folder with Images... S

Edit Single Image...

BAIDRIVIE, T71)V & LuminarllEBMNT 2 AEE T (TP Y RIVED ) v T5E 2DDE RAKRIINE
ED
s BEEAYTAILY—%EM... AVE1—9 EDBEFEDIAIVY —%Luminars4 7S UIEMLET,

s B—ERERE.. RBEDLOIE~DEEZLuminarllERYIAHE T,

1ﬁ ‘%f
A
Window Help

Small

Medium
v Large

Largest
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RDIDDRY VT, FvI—E1—DERY A XDRREERTCEET,
s VARMIWHYAX FvJ)—E1—TEBEZRITIEOBEET LRAMILDFERLRILODYRK,
o A—ALTIN RERTBHLRAIINDYAXEMHBNLET, TORFRTDX—LLR)VIE, LRSI TAXRER
THERTEET,
o =LAy RERITDYLRMINDYAXEIKALET,
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B CRA CEF I PDFIZA—T Y RIVF —RTY, 2FY, AVE1—FERTIE, AdobelHEMB &%
DK PDFERAEETEXBT7 S r—oav a2 ERTEE T, 2OA—T ki PDFOERRRIEAICD
BO>THY. A9 —Ry N ETELHBINTVWET,
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BEUREEXA—IL AvE—V%BLTEE LY. Y —vILAT AT HAMITy 7 O—RI255 1% A LB [EifR%EH
BIRIYVEI )L BEEROEE R EERIRLET . HERICKRTIINE A T2 av & RICRLEST  ARL—FT 1V
TORF LML TE, —8DA T avIidRIATEF A,

o A—=JVL EX=ILDAyE—UITIPEGERMMLET,
. Avt—Y BAZEEI51TY MAIPEGE Ayt —UEELET . (MacOSDH)
+ SmugMug 1D EH% SmugMug 7 AUV MI7y7O—KLET,

! 3=
SmugMug XY N—2vFiE R DY —E X TY , LuminarI TP V2R 9 3ICIE, — DY —>+
WY —EXDT ATV D RIEBEICRDZEDHYET,



20.3.1. Sharing an Image to 500px

File  Edit Library Image View Window Help
Catalog >
Add Folder with Images... Ctrl+Shift+N
Import Images to a Folder...

Edit Single Image... Ctrl+0

Add Luminar Looks Collection...

Export... Shift+Ctrl+E

SmugMug

S00px )\

Ctrl+B

You can quickly and easily share a photo to your 500px account. Get inspired with incredible photos from diverse
styles and genres around the world.

! Note: A 500px membership is a separate service.
You can learn more at https://500px.com/upgrade.

1. In your Luminar library select one photo that you’d like to share.
2. From the main menu choose File > Share > 500px or click the Share image button in the top toolbar
corner and choose 500px. A new dialog appears.
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Log in to 500px

3. Please wait while the edits are applied to your photo and it is converted to the right format for sharing.
If this is the first time sharing to 500px you will be prompted to log in to 500px.
4. Make your image easier to discover by adding:
+ Title
* Description
+ Category
* Location
+ Keywords
« EXIF data. For macOS users, the EXIF data is automatically sent. Windows users have a
checkbox to control whether EXIF data is uploaded.
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Into the Woods

Mystical wooded landscape

Uncategorized

Public

Georiga

Landscape, woods, mystical, trees, moss
NSFW Content

~ EXIF Data

5. Control access to your image by choosing a Privacy level:
* Public
* Private

6. If your image contains details unsuitable for children or the workplace, mark the box next to NSFW
(Not Safe For Work content).

7. Click the Upload button to add it to your 500px account.After pushing the Upload button, your photo
is automatically uploaded to the 500px website to the Photo manager section of your Profile.

8. On the 500px site, you can then browse and add your photo to the Gallery or edit its data in the Photo
manager section of your Profile.
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1IDOEERENOCEROEGEIFETS5E. ALRGREZERDOERICEATIEICLY, Z{DIGEEEZE
HTEEY, NI ARV M AR—Y R EDRKDEU T TELDRRDIITDEEERT I 21—F—ITRILD
TN\ FUIBHERIIIERICAHENEL ZHOEZEYMIEFIGERATEZ DA TYavsaFnTunET,

Ny FAIBDEILE
Ny FUIBARIBLELLD, CNICIX NIBTEEFRAHBIIL. REEBIRITIVELHYET,
1. BUIIORATY I3 . RGELEWEEAO—RTBZETYT . ZNIE 20D HETERITTEET:
o T7AIL > /Ny FHLIE

« Cmd+B (macOS) &7zl Ctrl+B (Windows) Z# L %7,
2. NyFUEBTZE{REZO-—RTILEN’HYET . INETIICEROAEEZFALET:
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Load images to Batch

Continue

o TPANELETANY %Ny FUREBI1VRIIIRSYILET,

o BB RYVEVIUVILET [P T I3 S0 A T2ar DA VIR >TWBRETIAILY —%8
IL735A. Luminar & BIIINTAINY —DEY T 74N T —TIRTCDERERRLET . 7T
F—avIilBgES T EEEEDLSAFET,

3. WEBYTHEREBIRLAEL. [ET5] RIVEBLT Ny FRIBOA S 3V EREERTLET,

INYTFAIBDERE

Ny FIBHEEISFEBICHRDLL ZIUSRZHOEGZEYMIERISER TESIFIFZRA T avsaiInT
W&,

MERRERAT T avIiZrROESYTT:

T4 NERTE

FATOT7DE LBICIE. Ny FUBORITAHEERETZEHNRT) 2y HYET, IhdlE ERINDT74
WDIATICBTEIRTDA TV avaEBLET (L L. BEEAEETIVLENHYET) BHINWTWE T Y

MIRDESYTY:

 Web JPEG Vx 7 HAMIBRBIZEBN TEITCVWBTI7MIEERLET,
o A=)V EX—JLEICEBEILINI/NRERI7/ILEERKLET,



« RBICHEALL BIE/FERALANYFREITYREETT,

Batch Settings

Luminar Look: Portrait : Al Face Enha.. ¢+ Amount @100

Overwrite without warning

Suffix Letters

QOriginal

Save Settings... Process

A—H—8&E

ZDEIAVIIFR AMERLEHSPDIHRYLT—I70—DEZFENTT . INOE. GEIOEREEFHALTEMRTEE
T ETHEHATEDLIIIINYFUEREAREFTBICE. T4V RIDTEICHD BREEREFE RIVEI)YILET,
Ty MIEhIUYRTWVWERIEFIFDEIICLTEIN,

INYFERTE
Ny FIBEERT DERDTED WO DEFREEEERTEIT,

« Luminar Looks ')ty hIdvhO—JL#EEAEA T2 &, Luminar Looks M SBIRTEE Y, IHICIE, HBEHS
NTWBTARTDLuminar Looks, 1~ A k=)L E N TWBLuminar Looks, 8 L U1 —H —HYERK L 7=Luminar
Looks BN EFENFE T, ZRMICHT IV AERIRL. RICELZDLuminar LooksZ:&IRLE T, [E] RSMY —%EH
L.Luminar Looks D& XA FFELTEXE T,

s BEZOFTVavEFERTZENBFEADI7AIVERETDIBMERIRTEF I IREDISAICIREEFETS
M BRLTHDIAIVY —%BIRTEFT BIRT DL 774D NRADPRAINFT AR TTDI7M) %
FEXTIARNEDIHZD NV FREBINT7AINETDI7AIVERBDF LW I ALY —ILRETZZ
CEBEIOLET,

« H0 Luminar 4ICIZFEB ISR T7AIN R EA T2av i hYET  EEFCERHLZEMLLY, IXIFER
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R—ZEHMNEBIRLICY AXFENLFEZEIRLIEYTEEZT, CICEY N\ FREBRIED—IRELTI74
WEFBICERBRICEBETEET,

o TA—IYMERTZI77MINDIATERIRLET /Ny FUEAIZIPEG,. PNG. TIFF, £/ I&PSD77 1)L %
ERRTEET,

o AZ—=OT7714I Chik, BDFEARYAEEHIELE T, 47> avIliE,. sSRGB, Adobe RGB, &0
ProPhoto RGBHM&ENZ T,

c VHAZX FHLWIFAILDTAAYav A GEISERIRLET,

* BV
[REARAE] RIVEI v oL BRICERATISLICREARETEET,
INYFDET

HETINYFUEBA T3V RIS D1V RIDETILHD L] REv %0 )y LTREERIRLET.
NICEY EITRRZETRTUEIAVRIODNRTIINZET,

« EIRBRVAVRVICRY, Ny FUEBIRFERIBR T HEICH OEKRZRIRTBICIE. V1V RUVDETICHS

[RB] RIV%D)vILET,
s NYFRBEIRTEFY LTI V1V RODELBICHDZ X 207)vILET,
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21. ¥F—R—K>a—hhybhF—

Luminar 4

Your
photograph
Elevated.

- s o
v ' — —

*—R—Roa— MY hDERIEA T3V TR BRAEKIEICEHNTEEY, UFEEFL. TN
EHRIEDT—IO—ICBIMLELED, ZODYDR—IENRITZEERTE, R—IEHRITS e
it A EBBOERIRY VAL TSI, . ‘

« macOSDF—HR—Ka—hAvhk
+ Windows®F¥—HhR—K>3—hAvEk
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21.1. macOSDOF*—hR—Ka—kAavh

Luminar - 4

— i

or o -

Tab

Space

>

<-

Cmd + ->
Cmd + <-
Cmd + click
Shift + click
Cmd+M

E74+—I7 79 —DLBETIBRIERLES . F—%7
ETTDEEIARRINET  F—4AM I & BIEINE
BOERTIINZET,

TOEGRD ZRIC REBRIVARICEREINS [2F]
BEELEE—N] ZEELET . E—RERTIBICE,; =
EI—EMLIET,

FrI)—E—RNICHWEX
AT ZVIRFICTPYE X
REET—NICTIVEZ

B/ ARILICTVE X
TIVAD)—=vEa1—
FTRTD/NARIVERNIERT
E—EEE1—/F+T)—E1—DREWIYEX
ROBEENHBE)
BIDEEANKBE
RDLooks~FEEl
ATDLooks ~F& &l
BHOERDEE%ER
BHEDERYT 2EEZRER

&=/ME

LuminarX=—1—

Cmd+H Luminar&3ER T

Alt + Cmd+H %IRRT

Cmd +Q Luminar&#& 7

cmd +, RIERE
T7AIAZa1—

Cmd+0O R(ZMv I RETEGR %)
Cmd +W 771V %=FLC3
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Shift + Cmd
+E

Cmd+B

Shift + Cmd
+P

Cmd+P

EgETIRAR—bN
Ny FUIBE—R%RL

R
N—VEXE

FIRI

WEA=1—

Cmd+2Z TRy

Shift + Cmd .

+7 )R

Cmd + X yANAN

Cmd+C JE—

Cmd+V R—2Z K

Cmd+A TRTGERR
Cmd+D TRORIRERR
Y—IL

c o0y 7Y—)L%ER<
Cmd+T BHZERY—I
Cmd+J JO—V&ARYVTY—)L
Alt J0—VDRRED%E=ER
Cmd+E ELILY—IL
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122 TFH
0D E T
fE LTS
AHAZIES
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Cmd + [
Cmd +]

Shift + Cmd
+8

Cmd+C
Cmd+V

Shift + Cmd
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B DHIBR

Cmd + Delete

Delete
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